
A few earlier but maybe still interesting Windows tips 

To the contents further down: Tips for Windows 7 and a little about Windows 8 - with a discussion 

of "Secure Boot" as a bad monopolization trick!  

Can Windows XP still be updated? 

Words of caution about Internet Security suites 

Word 2003   

I have occasionally noticed that certain settings became changed in my Word 2003. For example, 

the measurement units had become Inches, but I want Centimeters, and it could happen that some-

thing also changed in the menu bars on top. Sometimes also other things. Such settings for Word 

are stored in the file normal.dot, which is located in C:\Documents and Settings\[your 

name]\Application Data\Microsoft\Templates \normal.dot, but sometimes also in 

...\Office11\normal.dot – wherever you have installed Office. Many will have their Office 2003 in 

C:\Program Files\Microsoft Office\Office11. It may, furthermore, happen that Word pops up that 

it wants to change your normal.dot for some obscure reason (apparently under circumstances if you 

have opened more than one instance of Word). 

Where Word fetches normal.dot (usually C:\Documents and Settings\[your name]\Application 
Data\Microsoft\Templates\), it, when it starts, also stores a backup file ~$Normal.dot, which 

normally is automatically deleted when Word is terminated, but rarely it is not. If not, it could lead 

to changes in normal.dot at the next start of Word. And if Word crashes, it will often build up a 

new normal.dot next time it is started that may not be exactly the same as before. 

In order to avoid such unwanted changes, I have written the following batch file startwrd.bat, 
which I now use to start Word with (written for the more common case that your Office is in 

C:\Program Files\Microsoft Office\Office11: 

@echo off 
if exist C:\Docume~1\[your name]\Applic~1\Micros~1\Templa~1\~$Normal.dot del 
C:\Docume~1\[your name]\Applic~1\Micros~1\Templa~1\~$Normal.dot /A:H 

if exist C:\Progra~1\Micros~1\Office11\~$Normal.dot del 
C:\Progra~1\Micros~1\Office11\~$Normal.dot /A:H 

copy C:\normal.dot C:\Docume~1\[your name]1\Applic~1\Micros~1\Templa~1 /Y 

copy C:\normal.dot C:\Progra~1\Micros~1\Office11 /Y 

start  C:\Progra~1\Micros~1\Office11\WINWORD.EXE %1 

cls 

exit 

If [your name] contains a space or more letters than 8, set it in "...". This is for Windows XP! See 

below for Windows 7. 

A Backup of a normal.dot – such as I want to have it – is stored in the root folder in partition C:\, 
where also this batch file is stored. This normal.dot is copied to the two relevant locations and an 

already existing one there is overwritten (parameter /Y). If there is also a backup file ~$Normal.dot 
there, it is deleted (since this is a hidden file, there must also be a parameter “/A:H” at the end of 

“del ...”). Only then Word is started. The safety check “if exist” is, of course, not necessary, but 

serves the purpose that, in a possible case that something is wrong, not another file will be deleted 

in OFFICE11. This would be highly improbable but, as a German saying goes: “double-sown is 

stronger”... (comparable to “better safe than sorry” in English). 

According to the rule “8+3” of the good old DOS, folders are stated with the first 6 letters immedi-

ately followed by “~1”. One can also write the whole long name, but it must then be put between 

quotation marks, such as "Program Files" and "Documents and Settings". In the unlikely case 

that there would be another folder called “Microsoft [something]” in C:\Program Files, one may 

have to write “~2” instead of “~1” – or better, as stated above, the whole name in quotation marks: 

"Microsoft Office". 
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The icon on the desktop for starting Word shall run this batch file and not winword.exe directly. 

Therefore, the icon should be replaced with one that starts startwrd.bat, and then the icon image 

can then be changed to be the same as for Winword. The parameter “%1” after WINWORD.EXE 

has the effect that a double-click on a doc-file makes Word open this file when started. For that one 

needs to reset as follows: Right-click on any doc-file > “Open With” > “Choose program...” and 

then mark startwrd.bat (which will first have to be entered in the list with “Browse”). Put a mark 

below at “Always use the selected program to open this kind of file”. Do the same with rtf-files and 

the like, but not with any file for Excel or another Office program! 

This is here written without any guarantee or warranty. (I cannot exclude some mistyping when re-

writing the batch file for the more common case.) Who would like to apply this trick will have to 

adapt everything to his own system. The storage locations may be different in an individual case. Fur-

thermore, “[your name]” must be replaced with the name entered in your system. Take care that spac-

es are kept in the batch file and that no extra spaces are added. In case it shouldn’t work, a damage is 

highly unlikely, but you simply return to starting winword.exe directly, as before, and try to correct 

the batch file. One important thing, however, is that you backup normal.dot in the state it has now so 

that you can copy it back, if needed. Who knows a bit about theses things will get it right... 

Another location, where Office 2003 stores settings, is in the Registry at HKEY_USERS\S-1-5-21-[a 

long number, different from one case to another]\Software\Microsoft\Office\11.0\Word\Data\Settings. 

This cannot be manipulated but one may try to transfer it to another Office 2003 or to a new installa-

tion of it. For that purpose the entry to be transferred and also the existing entry in the other (or 

new) Office 2003 must be exported as reg-files. That is both, so that you can – in case something 

does not work well – reenter the earlier entry in the other Office and restore its original state. The 

“long number” may, however, be different in the two computers or installations, resp., and will then 

have to be modified accordingly in the reg-file. It is, in any case, a good idea to store a backup of 

that reg-file for a possible later need. 

Because of the different folder organizations in Windows 7, the batch file above (written for 

Windows XP) does not work there, but has to be restructured: 

@echo off  
if exist C:\Users\[your name]\AppData\Roaming\Micros~1\Templa~1\~$Normal.dot del 
C:\Users\[your name]\AppData\Roaming\Micros~1\Templa~1\~$Normal.dot /A:H 

if exist C:\Progra~1\Micros~1\Office11\~$Normal.dot del 
C:\Progra~1\Micros~1\Office11\~$Normal.dot /A:H 

copy C:\normal.dot C:\Users\[your name]\AppData\Roaming\Micros~1\Templa~1 /Y 

copy C:\normal.dot C:\Progra~1\Micros~1\Office11 /Y 

start C:\_OFFICE\Office~1\OFFICE11\WINWORD.EXE %1 

cls 

exit 

To transfer Word 2003 macros to another computer 
In the source computer: Open Tools > Macro, click “Macros”, then “Edit”. Copy the whole content 

as a something.txt file. 

In the target computer: Create some macro. Open Tools > Macro, click “Macros”, then “Edit”. 

Copy the contents of the something.txt file, overwriting. 

Custom icons to run Macros in Microsoft Word 2003 
Copy the Macro to a toolbar: Open Tools > Customize > Macros and drag the image to the toolbar. 

Right click the image, click “Customize” (at the bottom of the appearing list). 

While that little window is still there: right-click the macro image again. A list of options appears. 

From that list you can copy, paste, edit etc. the macro image to make an individual icon. 

Special characters   

If you write in a few different languages and need special characters like å, ñ, š, č, ¿ and so on, you 

can install a very useful little freeware application called Accents from this website, which puts such 

http://www.donationcoder.com/Software/Skrommel/
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a character on the screen through pressing a corresponding key three or more times. Still better is to 

use the freeware Keyboard Layout Creator from Microsoft. I used it to reprogram my German key-

board with additional functions, so that I get the Swedish å when I press AltGr+ä, the Spanish ñ 

when I press AltGr+n, and so on, and that in every application. If you use MS Word 2003, you can 

install the very helpful free add-on International Character Toolbar, but it works only in MS Office 

2003. Regrettably, nothing similar seems to be available for other versions of MS Word. There you 

may, instead, create shortcuts to certain characters if you from the menu choose Insert > Symbol, 

pick the character and then click Shortcut Key. Again, this the only works for MS Word. 

A special little nastiness of Microsoft to manipulate bssym7.ttf or Bookshelf Symbols 7.  

Microsoft has with an old update KB833404 removed this symbol font entirely from Office 2003 or, resp., with another 

update KN833407 only removed “unacceptable” symbols from it. In the general update SP3, the latter update is built-in 

so that it cannot be removed. In later Office systems it will be accordingly from the beginning. The special symbols 

concerned are a swastika and a star of David ‒ symbols I never need, especially not the swastika. What bugs me is only 

that Microsoft wants to patronize and decide what I shall have in my computer, and what not  That is going too far and 

is non of the matter of Microsoft! Therefore, this already long ago challenged me to circumvent this patronization, even 

though I will never need these symbols and have nothing whatsoever to do with excrement-brown Nazi junk. It turns 

out that the symbols are still inside bssym7.ttf, but get filtered out in some manner. Thus the original state can be recre-

ated as follows. Copy bssym7.ttf to a suitable folder and rename it to bssym8.ttf. Then open the file in a suitable Text 

Editor (e.g.. UltraEdit), find and change the contents as follows: Symbol 7 to Symbol 8, Symbol Seven to Symbol 

Eight, S y m b o l 7 to S y m b o l 8 and S y m b o l S e v e n to S y m b o l E i g h t (notice the spacing between let-

ters!). Then store the change. If bssym8.ttf is now installed, it will have the original content of bssym7.ttf... The matter 

of Copyright may here be raised, but since Microsoft gave me the font for free with earlier systems, I consider it to be 

my freedom to keep it functioning, if I want to, and not to have again taken away from me what they already gave me. 

As mentioned, this is not in any way important for me in this case, but a matter of principle. More annoying is that some 

other fonts are declared to no more work with later Windows and Office versions. Bookshelf Symbol 1 and 2 are said to 

no more work. However, the Bookshelf Symbol 1 font (bssym1.ttf) does install and works! Who – maybe – wants it and 

no more has it from earlier systems, will find it in the Internet. As concerns Bookshelf Symbol 2 (bssym2.ttf), the ver-

sion 2.01 can be installed, but the symbols do not appear, yet an earlier version (with less symbols) 1.05 can be found, 

that works in Windows XP and 7 with Office 2003 (and still higher?). I sometimes use various symbol fonts, especially 

when I need letters with diacritics and other special letters, and – of course – find elsewhere what I need. Yet it is a bit 

annoying that Microsoft tells us that fonts cannot be used, when it isn’t always true! As is the case with bssym1.ttf... 

and I could also, just for the try, make Arial Cyr (aricyr.ttf) work, even if I apparently shouldn't... I may one day be able 

to hack bssym2.ttf V2.01 also... just for the challenge when I have nothing else to do (which rarely happens). 

A useful tip  

Some will already know it and others will appreciate it. How do you fixate an ink printout? There 

are rather expensive fixative sprays, used, e.g., for pencil drawings. But a common hairspray does it 

just as well! 

Refilling ink cartridges  
Use with Linux: It is hard to find an easily installed driver for Canon Pixma iP4000 in Linux. But I 

discovered an excellent application that operates not only Canon Pixma iP4000 but also many other 

printers in Linux: TurboPrint from ZEDOnet. 

Tips and comments for WINDOWS 7 

The champion of annoyances – until Windows 8 stole the show from it... 
What I do not like at all is the impudence of Microsoft to block the access to certain folders! It is 

definitely not Microsoft’s business at all what I do in my own computer (as long as I don’t abuse it 

for hack & crack)! I, after all, paid for it to be mine and to do what I want with it. But there is a little 

tool takeownership that can open the access to such folders. BUT BE CAREFUL!!! In my delight, I 

immediately opened ALL blocked folders – and that worked, so far, but then certain software func-

tions no more worked! I had to install Windows again. Luckily, I hadn’t come far with it. It is ad-

visable to ONLY open access to user folders and never to system folders. Takeownesrship adds a 

new entry “Takeownership” in the context menu. Choose the folder to open, right-click on it and 

then click that entry. But do set a restore point before you do that! Just in case… A backup of the 

registry may be enough. A solution that can be reversed is this one. Here, here and here are descrip-

tions in English about how to at least in part overcome this nonsense. But respect the warnings! 

http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=22339
https://downloads.guru/Download-Microsoft-Office-2003-International-Character-Toolbar-for-Windows/
http://www.turboprint.info/
http://www.howtogeek.com/howto/windows-vista/add-take-ownership-to-explorer-right-click-menu-in-vista/
http://winaero.com/comment.php?comment.news.18
http://www.sevenforums.com/system-security/24035-domain-users-super-admin-account.html
http://www.vistax64.com/tutorials/67717-take-ownership-file.html
http://www.sevenforums.com/tutorials/1911-take-ownership-shortcut.html
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Why does Microsoft want to keep us in their leading-strings? This is supposed to serve safety, since 

hackers, viruses (and unauthorized persons) cannot change, add or remove certain files. That is non-

sense! In reality it reduces safety, since hackers etc. will already long have found out how to over-

come these obstacles. Thus they can do things in the system – but the owner cannot access sensitive 

areas to check and if needed correct… (for Microsoft, this is of course no obstacle against spying in 

your computer). 

But if you, like me, have Windows XP in a separate partition, this offers certain possibilities to en-

ter blocked Windows 7 files through a “back door”. 

A small batch file for regedit  

that I had already in Windows XP. When you run regedit, it starts where you were last time in the 

registry. Sometimes useful, more often not. The following reg-file that I call LastKey0.reg starts it 

at the beginning: 

 Windows Registry Editor Version 5.00  
   
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Regedit]
  
 "View"=hex:2c,00,00,00,02,00,00,00,03,00,00,00,ff,ff,ff,ff,ff,ff,ff,ff,ff,ff,\  
 ff,ff,ff,ff,ff,ff,42,00,00,00,42,00,00,00,42,03,00,00,5b,02,00,00,d6,00,00,\  
 00,da,00,00,00,78,00,00,00,b3,01,00,00,01,00,00,00  
 "FindFlags"=dword:00000002  
 "LastKey"="My Computer"  
   
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Applets\Regedit\F
avorites] 

I use it with the following batch file that I call LastKey0.bat: 

 @echo off  
 REGEDIT /S LastKey0.reg  
 start C:\Windows\regedit.exe  
 exit 

When I run regedit with it, it always starts at the beginning of the registry. One can no doubt join 

the reg- and the bat-file to one, but I have not yet bothered about it. However, it may not work if 

UAC prevents loading the reg-file. See here how to set the UAC. 

What I find really annoying in Windows 7 and means against it 
Windows Explorer starts with “Libraries” and Favorites”, which for most users is quite useless, 

rather annoying and a waste of space. See here how to get rid of this nonsense.  For defining a start 

folder, see here, here and here. 

A useful tool for this purpose is the Windows Explorer Navigation Pane Configurator (this is a di-

rect download link). Instructions in English are found here. See also this text for another tool. An-

other tool is the Windows 7 Navigation Pane Customizer. 

Many a file cannot be deleted since it is protected by “Trusted Installer”. How to circumvent this 

questionable “protection” is described here. See also this. 

The excellent freeware ERUNT for backing up the registry in Windows XP has not yet been 

adapted to Windows 7 and it appears that it will never be... One alternative for Windows 7 would 

then be Tweaking Registry Backup. Another program that makes a backup of the registry is Regis-

try First Aid. Many Internet articles do, however, warn against using “registry cleaners”, since they 

may overdo things and remove entries that shouldn’t be removed so that you then could have seri-

ous problems. But the backup function is useful. Therefore, do first make a backup of the registry 

before you attempt any such “cleaning”!  

http://www.christian-reincarnation.com/ComFreakENG.htm#UAC
http://www.petri.co.il/remove-libraries-and-favorites-from-windows-explorer.htm
http://www.mydigitallife.info/trick-to-open-computer-or-documents-as-default-instead-of-libraries-folder-with-windows-explorer-on-windows-7/
http://www.mydigitallife.info/how-to-change-windows-explorer-default-folder/
http://www.maxi-pedia.com/Windows+7+Explorer+default+folder
https://github.com/andif888/wenpcfg
http://www.s-inn.de/download/wenpcfg-Readme.pdf
http://www.askvg.com/how-to-fix-annoying-folder-view-type-problem-in-windows-vista/
http://www.door2windows.com/windows-7-navigation-pane-customizer-show-hide-rename-items-in-windows-explorer-navigation-pane/
http://helpdeskgeek.com/windows-7/windows-7-how-to-delete-files-protected-by-trustedinstaller/
http://www.askvg.com/guide-how-to-restore-trustedinstaller-as-default-owner-of-a-file-or-folder-in-windows/
http://larshederer.homepage.t-online.de/erunt/
http://www.tweaking.com/content/page/registry_backup.html
http://www.registry-repair-software.com/
http://www.registry-repair-software.com/
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When an external storage is connected to USB, the annoying question pops up: .”Do you want to 

scan and fix Removable Disk?” Here is explained how to get rid of it, though at the price of just a 

few in my view unimportant functions. I have disabled the service Shell Hardware Detection and 

still can scan images, and I don't need the Autoplay function and have noticed no other negative ef-

fects yet. I prefer to no more have this annoying message. It does, however, not work in all cases. 

Here is well justified critique of Windows 7. 

How to start an application as administrator is written about here, and here how to arrange Control 

Panel they way you want it. It is in certain cases suitable to open the Command Window (Command 

Prompt) cmd as administrator, as is explained here. 

Open and close the Internet connection. The Internet connection is active all the time and that is 

not very desirable when you don’t need it. This is actually also a matter of security. I suggest to put 

a link to %windir%\system32\control.exe netconnections on your desktop. After a double-

click on the icon, you arrive at Network Connections, and there can click the icon Local area 
Connection. Click “Disable” in the window that pops up and the network connection is interrupt-

ed. Or better: right-click the icon and then click “Disable”. This can be seen in the little icon Net-
work Internet access in the system tray as a red x. To reconnect, you again go there and just 

double-click Local area Connection, and you are in again. I would, however, suggest to copy 

and drop the icon Local Area Connection to the desktop to have it directly available there, and 

then delete the former icon. Hold down the Ctrl key and drag the icon to the desktop. But be sure to 

hold down the Ctrl key or you may not copy, but move the icon and that can cause problems. 

Do you like the start menu of Windows 7?  

In any case, I do like it less than the one in XP! But it will also be a matter of getting used to it. 

Here, here and here, however, a plug-in “Classic Shell” is described that restores the start menu of 

Windows XP in Windows 7 – and that with a few functions that Windows 7 no more has. The latest 

version is found here (also the version with support for Windows 8 is for Windows 7!). You then 

have the choice to start with the one start menu or the other (clicking the start symbol with the 

CTRL key pressed gives you the version for Windows 7). What I find especially clumsy in Win-

dows 7 is the “Copy UI” (see here) that with Classic Shell suitably appears like in XP again. The 

basic appearance may be a bit less attractive, but there are skins that make it look a lot better and 

additional skins can be downloaded. Try it out. An alternative to Classic Shell is Start Menu X. It 

works with Windows 7 and 8. 

Thus I slowly get Windows 7 to where I can begin to like it... 

Some services can at an advantage be disabled that otherwise run unused in the background. Black 

Viper has valuable tips for this. 

Do you miss icons in the system tray? Click the little upward arrow ^ there and a bubble appears, in 

which you see icons that are not shown in the tray. If you there click “Customize”, you can choose 

which ones should be seen in the tray. You may also click  “Always show all icons...”, and then you will 

have them all in the tray. To reverse this, click at an empty space in the tray and then choose “Custom-

ize notification icons”. The earlier arrangement in XP was much better: rarely used icons were not 

shown, but appeared in the tray itself after clicking a left-pointing arrow, without a silly bubble. 

It makes a certain sense to see all the icons (or most of them) there. As mentioned above, 

PowerDesk, when turned off, doesn’t stop a certain service that continues in the background. This 

was so with that application also in XP, but in Windows 7 this may happen with a few more appli-

cations. These are then better turned off via the icon in the tray: right-click and then click “Exit”. 

The quick-launch bar is regrettably missing in Windows 7. One can, instead, pin icons to the 

taskbar, which is not very satisfying. These icons are then a bit far apart, so that they with these dis-

tances occupy too much space in the taskbar, which is much less satisfying. Thus the good old 

quick-launch bar must be restored! How to do this, is described here. Then the quick-launch bar is 

http://www.ghacks.net/2010/11/27/disable-do-you-want-to-scan-and-fix-removable-disk-autoplay/
http://en.windows7sins.org/
http://www.sevenforums.com/tutorials/11841-run-administrator.html
http://www.sevenforums.com/tutorials/262-control-panel-view-category-icons.html
http://www.sevenforums.com/tutorials/47415-open-command-window-here-administrator.html
http://www.codeproject.com/Articles/45430/Classic-Shell
http://classicshell.sourceforge.net/index.html
http://classicshell.sourceforge.net/faq.html
http://classicshell.sourceforge.net/
http://www.codeproject.com/Articles/45430/Classic-Shell
http://www.startmenux.com/index.html
http://www.blackviper.com/2010/12/17/black-vipers-windows-7-service-pack-1-service-configurations/
http://www.blackviper.com/2010/12/17/black-vipers-windows-7-service-pack-1-service-configurations/
http://www.sevenforums.com/tutorials/888-quick-launch-enable-disable.html
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positioned to the right in the taskbar, which also isn’t good. In earlier versions of Windows, it was 

located at the left end of the taskbar, and that state must also be restored. See point 8 in the link 

mentioned. Now you can remove pinned icons from the taskbar: right-click and choose “unpin”. 

These icons are then much better imported in the quick-launch bar: hold down the CTRL key and 

drag and drop them (copying) in the quick-launch bar (without pressing CTRL, they will be moved 

there instead of copied). If you want to remove the quick-launch bar again, it is simply done as de-

scribed under “Option two” in the link mentioned. Then it is completely gone and cannot be re-

stored in a similarly simple way, instead you have to repeat the whole procedure. If after this a little 

tricky procedure you don’t have the quick-launch bar where you want it, you have to remove it and 

start all over again... 

Three more descriptions of restoring the quick-launch bar: here, here and here. If you would like to 

have the taskbar more like in Windows Vista or XP, here is how. 

Annoying desktop.ini icons  

A couple of irritating and useless icons “desktop.ini” can be seen on the desktop. How can you get 

rid of them? One should not delete the corresponding files, but if you try to delete the icons, you in 

this case also delete the files... The common “tip” is to go to Windows Explorer and under “Organ-

ize” > “Folder and Search Options” > “View” check “Hide protected operating system files (Rec-

ommended)”. I don’t like that at all, because I don’t want to hide them generally! There is another 

“tip” around in the Internet that works with earlier versions of Windows, but not version 7... The 

only solution seems to me to be: move them out from the desktop surface, over the edge! 

Portable programs  

are becoming increasingly popular these days. They are not only useful for your USB stick in the 

pocket, but also for your lap- and desktop, since they normally don’t put entries in your Registry 

and still more rarely start a service that they (if at all started) don’t stop again after use. They, there-

fore, load your system less and contribute less to slowing it down than the fully installed program. 

The interesting ones are in my view Portable Apps and Lupo Pen. LiberKey is also interesting but 

less flexible. (McAfee Site Advisor warns about a “dangerous site” when you open the Lupo Pen 

website, but that is doubtlessly not valid! It will be “historical”, since that site appears to earlier 

have had just a few unlicensed applications it no more has.) 

Uninstallable programs  

Some programs don’t install in Windows 7, because they are written for Windows XP or even earli-

er versions. In some cases it can be installed in the compatibility mode for XP (or an even earlier 

version). For that, click right on the installation file and then “Properties” and there open “Compati-

bility”. But that doesn't always work. With some luck, you may nevertheless be able to make them 

work in Windows 7. To try that out, first copy the program folder from, e.g., Windows XP to Win-

dows 7. Then search and find all entries in the Windows XP registry that refer to that program and 

export them to then import them in the Windows 7 registry. CAUTION! There is a registry entry 

HKEY_USERS\S-1-5... followed by a series of long numbers. Here, the reg-file must be edited to 

enter the appropriate number for your Windows 7, since it will differ from the one in Windows XP. 

If you install the program in another folder in Windows 7 than it has in Windows XP, you will also 

have to edit the reg-files and change the program location to the new one. 

If the application is associated with a certain file extension, so that it should open when you double-

click such a file, this extension also needs to be entered under HKEY_CLASSES_ROOT. The easi-

est and safest way to do that is to right-click such a file, click “Open with” and then “Choose default 

program”, mark “Always use the selected program...”, browse for your newly installed application 

and click it. That way, the extension is automatically entered with its proper association under 

HKEY_CLASSES_ROOT. 

CAUTION! Back up your registry first or create a restore point so that you can reverse this if some-

thing goes wrong! There will also be a corresponding folder in Windows XP under “Documents and 

Settings” that in Windows 7 has to be inserted under a different location: usually in [your 

https://support.microsoft.com/kb/975784
http://www.howtogeek.com/howto/windows-7/add-the-quick-launch-bar-to-the-taskbar-in-windows-7/
http://www.bleepingcomputer.com/tutorials/enable-or-disable-quick-launch-in-windows/
http://www.howtogeek.com/howto/windows-7/make-the-windows-7-taskbar-work-more-like-windows-xp-or-vista/
http://portableapps.com/
http://www.lupopensuite.com/
http://www.liberkey.com/en/
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name]\AppData\Roaming... If the program complains that it doesn’t find a certain file, such as a 

DLL file, find that file in Windows XP and note its location. Then copy it under the same location 

into Windows 7. If it doesn’t work but also doesn’t complain about a file not found, try to find other 

files it needs using the freeware Dependency Walker. Another file to watch for is an INI file, if the 

program has one. It will then in most cases be located in C:\Windows and have the same name as 

the program. This needs to be copied to the same location in Windows 7. 

This way, I even managed to make an old but good 16-bit program for Windows for Workgroups 

3.11 work in Windows 7! It even didn’t install in Windows XP, but it did in Windows 2000. So I 

first used this procedure long ago to make it work in Windows XP – and now I in the same manner 

copied it from Windows XP to Windows 7, and it works! It is Gamma Universe, a small program 

that writes in various different alphabets like Sanskrit’s Devanagari, Tibetan, Malayalam, Hebrew 

an so on. I rarely need it, but when I do, I am really happy that it still does work for me! I, for ex-

ample, used it here. 

Another idea that I haven’t tried yet would be to make a program portable (see also here) in Win-

dows XP and then use that in Windows 7. 

Reinstall Windows 7  

without loosing data, accounts, installed programs and drivers (so that you will not need to reinstall 

them, too) can be done like this. 

User Account Control (UAC)  

This p.i.a. function is a real annoyance in that it pops up every now and then with the question if 

one really wants to start an application, or not. It is supposed to have a protective function in that 

one can in time stop a malware or an unknown program from starting. In practice, however, it be-

comes quite offensive since one over and over again has to repeat permitting the start. That rather 

makes it contra productive and turns the alleged protection into a risk, because:  

1. a large number of users prefer to turn it off rather than having to repeat permitting these pop-ups 

all the time,  

2. one with time will quite routinely click permission without looking carefully what it is that wants 

to start. 

It is possible to stop this repeated request for permission for singular applications. Here and here two 

procedures are described for this purpose, but they are both rather complicated and not suited for a 

larger number of applications. This will be a better solution that, however, requires that an additional 

service runs in the background and, therefore, should preferably autostart. This will be a still better 

solution since it introduces a new mode of operation for the UAC: a quiet mode! In that mode, it 

doesn’t display an elevation prompt for administrators, but still keeps a protective function. Yet I 

consider the annoying UAC to be of little value if you have a good Internet Security Suite! 

The latter can also be achieved without that tool with apparently little known settings in the Registry: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System]“C

onsentPromptBehaviorAdmin” 

and 

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System]“C

onsentPromptBehaviorUser” 

Change the values from their default of 2 to 0 to enable UAC quiet mode. 

Here is another tip from a Forum:  

“Click the Windows button, type secpol.msc and hit enter/return.  On the left, expand 'local poli-

cies' then go into security options submenu.  On the right, scroll down to the bottom and you'll see 

10 different options for User Account Control.  You can make it do whatever you want from here, 

including never to prompt you again. 

Expand windows and columns as needed to see these options.  Be careful if you don't know what you're 

doing.  Read the explanations for each security option twice before deciding to change anything. 

http://dependencywalker.com/
http://www.christian-reincarnation.com/PDF/Marma.pdf
http://www.inshame.com/2011/04/how-to-create-portable-applications.html
http://portableapps.com/node/9909
http://windowssecrets.com/top-story/win7s-no-reformat-nondestructive-reinstall/
http://www.sevenforums.com/tutorials/11949-elevated-program-shortcut-without-uac-prompt-create.html
http://cybernetnews.com/helpful-tip-disable-uac-prompt-for-an-application/
http://www.itknowledge24.com/downloads/uac-trust-shortcut.php
https://www.techrepublic.com/blog/windows-and-office/disable-vistas-user-account-control-prompts-while-protecting-your-system/
https://www.techrepublic.com/blog/windows-and-office/disable-vistas-user-account-control-prompts-while-protecting-your-system/
http://forums.joeuser.com/366901
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In case of UAC annoyances with autostart programs: Setup an Elevated Privilege Startup in the 

Task Scheduler.” 

An interesting application is the Vista UAC Maker that also works in Windows 7. 

Furthermore, Hackers &Co will beyond doubt already long know how to circumvent the alleged 

protection by the UAC! 

Certain CDs and DVDs may not be recognized in Windows 7 
This may occur with CDs and DVDs written in Windows XP. Here is a hotfix from Microsoft that 

solves the problem. 

Planned obsolescence  

The industry widely uses the concept of planned obsolescence to make products last only a limited 

time (or be unrepairable) so as to force customers to buy anew. In the computer industry, the con-

cept is to day used, for example, in most printers. Software manufacturers also try to make their 

products planned to become obsolete with time, so that an older version will no more work in a 

newer operating system, or the other way around: that a newer version doesn’t operate with an older 

operating system. Microsoft is, of course, also doing the best they can along these lines. One way is 

to no more update the system to fix vulnerabilities discovered later. Another way seems to be to 

have agreements with motherboard manufacturers, so that an older system (such as Windows 98SE) 

no more installs with a newer motherboard (and that many motherboards don’t install Linux or run 

well with it!). But since planned obsolescence cannot be so straight forward in the case of operating 

systems as with such things as hardware and mechanical devices, they push the “style” or “fashion 

obsolescence” with the intention that everyone should run like mad after every new version of Win-

dows, even though the new version doesn’t really have an important advantage, but in many cases 

even disadvantages and annoyances... Disadvantageous system were (see below) Windows ME and 

Windows Vista. And even if Windows 7 is better than Windows Vista, it in my view has no real 

advantages over Windows XP at all! But it does have a considerable number of annoyances... 

Therefore, I am quite disappointed about Windows 7! 

See this note and this cartoon. 

It is really regrettable that it takes so much effort to “correct” Windows 7 and get it in a rea-

sonably decent shape! It may be OK when it in the beginning is conceived more for a lay-user, 

but it should certainly be easier to rearrange it to a more professional arrangement, and that 

should actually be so from the beginning in the Pro and Ultimate versions! In many applica-

tions, you can choose between a “standard” (simple) and an “advanced” setting, and this is 

one of the features missing in Windows 7. 

The transition from Windows 2000 to Windows XP was a step forward, but the further tran-

sition to Windows 7 was partly a step backward. Windows XP didn’t by any comparison in-

troduce as many annoyances as Windows 7 does, and didn’t by far need so many corrective 

measures to overcome them. And Windows 7 wants to infantilize the user a lot more than 

Windows XP ever did... 

Removed (in some cases lost) features in Windows 7. New (in some cases annoying) features in 

Windows 7. 

In view of such “development” tendencies, you will hardly find Windows 8 in my computer (espe-

cially with the alienating tile-based desktop!). Then rather Linux! I have installed both Ubuntu and 

Linux Mint in my laptop to try them out and compare them. I like Ubuntu, also optically. However, 

Mint is functionally a bit better (and it is based on Ubuntu). Therefore, I have divided the 1 TB 

hard-disk in my new desktop in three partitions: two for Windows XP Pro and Windows 7 Ultimate, 

resp., and a third for Linux Mint. I intend to work more with the latter  in the future. 

Microsoft flops (fair-use quotes from Techspot)  

“Microsoft Windows Me – The ‘mistake’ edition  

http://www.securityxploded.com/vistauacmaker.php
http://support.microsoft.com/kb/2566584
http://en.wikipedia.org/wiki/Planned_obsolescence
http://en.windows7sins.org/flyer.pdf
http://www.gnu.org/graphics/jesus-cartoon.jpg
https://en.wikipedia.org/wiki/List_of_features_removed_in_Windows_7
https://en.wikipedia.org/wiki/Features_new_to_Windows_7
http://www.techspot.com/guides/511-tech-fail/
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Backtracking on plans to make Windows 98 the last OS before switching to NT builds, Microsoft 

shipped two more 9x-based platforms: Windows 98 SE (April ’99) and Windows Me (September 

’00). The former was a revamped version of Win98, while the latter was an awkward interim re-

lease that arrived shortly after the venerable Windows 2000. Me was unstable and had fewer fea-

tures than 98 and 2k, making it a tough sell and a horrible OS experience out of the box.” 

COMMENTS: In my view, Windows 98SE was a really good OS (better than Win98 and a lot bet-

ter than Win95), but Windows Me was a bit of a bluff, since it pretended to not be DOS-based 

(DOS was hidden in it)... To me, it rather appeared to be a way to make some extra money while 

developments were going on, and I never used it. The only advantage with Me was that it had a bet-

ter defragmentation and a batter scandisk, and that one could copy the files used for it to Windows 

98SE and let them there replace the corresponding files! 

The first OS I used was Windows for Workgroups 3.11 and it was really good at that time. It is a 

pity that an alternative OS called OS/2 Warp was lost in the run, since it could possibly have over-

taken Windows and become an even better system. But Microsoft conquered it with a very clever 

marketing. Letting a computer manufacturer have Windows almost for free soon led to the situation 

in which almost every new computer had it. And since nearly everyone then had Windows and 

would have had to pay for OS/2, the interest in the latter was lost. Another very promising attempt 

was BeOS. The company was bankrupted by the competition and had to give up. It focused a lot on 

multimedia but was weak in office applications, where, however, the big paying customer market 

would have been. With a good choice of attractive office applications it might have survived. 

Then came Windows 95, and I asked myself: What do we need that for? But when it later came to 

Windows 98SE, the concept had matured to a really good OS. The best system Microsoft ever had 

was and is, however, Windows XP, where XP stands for eXPerience (and not, as one might first 

have thought, eXPeriment...). Windows 7 is hardly much better but in my view has quite a few 

drawbacks that need to be overcome, as I have described above. It is claimed to be faster, but every 

newly installed Windows is fast an then slows down with time, and so will Windows 7... (And 

Windows 2000 may still remain an OS worth considering.) 

“Windows Vista – Six flavors of fail  
After repeated setbacks, Windows Vista finally launched with a confusing array of six editions dur-

ing the slow PC sales month of January. Ironically, part of the final delay was used to ‘crank up’ 

Vista’s security and uptight security became one of critics’ main complaints. There were also nu-

merous software incompatibilities, various performance issues (gaming/file transfers/battery life), 

and it failed to deliver promised features such as WinFS.” 

COMMENTS: I never used Vista, either (except in an Internet Coffee-Shop or two). It to me ap-

peared to be merely an interim experiment with technologies later to be adopted in Windows 7 

when matured, again making some money in the meantime. 

Of course, Macintosh must be mentioned. It seems to be like religions if you favor Macintosh or Win-

dows. I have almost no experience with the former and can only remark that it is a real pity that an ob-

viously valuable software is tied to the hardware, so that you cannot buy the OS and install it in any 

computer. The fact that you have to buy a computer with the OS in my view limits the attractiveness. If 

I could have had it as an alternative OS in the same computer for easy comparison, I might have 

changed my mind. But you don’t just like that buy a second computer to be able to compare! And cer-

tainly not a NEW computer when Apple issues a new version that cannot be upgraded to in the one you 

already have!! Microsoft will be quite happy about that... And the choice of applications you can have 

on the market (or even get as freeware) is obviously quite a lot bigger with Windows... 

Now free OS systems seem to be on the increase. Linux has become a lot more attractive through 

Ubuntu, which I consider to be a really interesting alternative to Windows. Linux Mint is based on 

Ubuntu but has some functional advantages, and the latter’s graphical appearance is a bit nicer. But 

FreeBSD is obviously an alternative well worth considering. 

https://en.wikipedia.org/wiki/OS/2
https://en.wikipedia.org/wiki/BeOS
https://en.wikipedia.org/wiki/WinFS
https://en.wikipedia.org/wiki/Macintosh
http://www.ubuntu.com/
http://linuxmint.com/
https://en.wikipedia.org/wiki/FreeBSD
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Some comments about and tips for Windows 8 
Thus I can put no big hope in Windows 8, which already announces still more suicidal annoyances, 

beyond the limit of what we can barely take with version 7 (such as no start button, no start menu 

and the silly tablet style interface with clumsy tiles). It is also designed for a touch screen. In Win-

dows 7, you can at an advantage modify start button and menu (see above), but in Version 8 Mi-

crosoft may allegedly try to block such modifications! There are, however, solutions (see below). 

Good bye stupidifying Windows! Hello Linux! 

Even though I don’t want Windows 8, I nevertheless give a few tips from computer magazines. The 

clumsy tablet interface “Metro Suite” can be circumvented with Win 8 Starter or Win 8 Start But-

ton, so that Windows will start more or less like earlier versions. The is achieved with „Classic 

Shell“ or Start Menu X mentioned above. Further programs for the same purpose is Skip Metro 

Suite, also here, as well as Spesoft Free Windows 8 Start Menu, Start Button 8 and  Pokki. See also 

Start Menu Modifier. So many programs to adjust that silly tile screen is a clear symptom that hard-

ly anyone likes it! Windows 8 by default has a Smartscreen Filter installed that – no matter what 

browser you are using – checks each and every download and reports it to Microsoft! Allegedly as 

a security against malware (Windows warns, after checking back with Microsoft, if a malware is 

suspected), but: that way Microsoft also knows what programs the user downloads and installs! Es-

pionage! (That Microsoft denies this cannot be taken fully seriously...) This Smartscreen can how-

ever, be deactivated, see also here. To get the start menu back like in earlier Windows versions you 

may in certain cases need a tool Vistart 8. Furthermore, Windows 8 plays no movies! At least not 

from DVDs. Codecs are missing (except for AVI, MPEG and WMV). One therefore has to install, 

e.g., VLC Media Player! Hence, one will have even more work here to eliminate all the annoyanc-

es!!! But without me...! 

With Windows 8.1, Microsoft finally reacted to the poor acceptance of the clumsy tile desk-

top... Maybe just a few of the above supernuisances have also been rectified. 

Another serious mistake Microsoft did with Windows 8 is that the so called Metro Apps (now 

called Windows Store Apps) are available only through the Windows Store and not from competing 

software stores. This has, however, already been pirated. Furthermore, certain games are censored 

out from Windows Store. I think that playing games in the computer is useless waste of time and 

computer facilities (and an autoinfantilization to play war and violence games), but many a comput-

er user will be highly irritated by that. That is why a German computer magazine Linux Intern 

thanked Microsoft for making many users now more interested in Linux than ever before! 

A REALLY DIRTY MONOPOLIZATION TRICK!!! 
Windows 8 includes “Secure Boot” when installed in a computer with UEFI ‒ a new kind of BIOS. 

This prevents booting from many or probably almost all boot-CDs/DVDs. But much worse: It also pre-

vents booting from another OS ‒ such as Linux ‒ that you may have installed (or want to install) in an-

other partition in your computer, which boils down to a very nasty monopolization trick!!! But this 

“feature” can be disabled, see here. See also here, cf. here and here. However, the procedure may be dif-

ferent in different computers and possibly not work in all of them, especially not in computers with a 

Windows 8 ARM Hardware. A Linux user group filed a complaint with the European Commission al-

leging Microsoft's UEFI practices violate antitrust laws and I hope that they will be successful! This is 

for me ‒ and probably for many ‒ one more reason to NOT WANT WINDOWS 8! 

And when you buy a new computer, first make sure that this “Secure Boot” BS can be deac-

tivated in it and avoid computers with Windows 8 preinstalled! Don’t buy a computer with 

Windows 8 ARM hardware! A BIOS compatible mode can in most computers be activated 

before the installation, instead of UEFI. 
 

http://www.pcworld.com/article/256570/microsoft_thwarts_start_button_hacks_as_new_windows_8_build_launches.html
http://www.win8starter.com/
http://windows8startbutton.com/
http://windows8startbutton.com/
http://www.christian-reincarnation.com/ComFreakENG.htm#CLS
http://www.christian-reincarnation.com/ComFreakENG.htm#CLS
http://www.startmenux.com/index.html
http://www.downloadcrew.com/article/28076-skip_metro_suite
http://www.downloadcrew.com/article/28076-skip_metro_suite
http://winaero.com/comment.php?comment.news.103
http://www.spesoft.com/free-windows-8-start-menu.aspx
http://www.startbutton8.com/index.html
https://www.pokki.com/windows-8-start-menu
http://www.neowin.net/forum/topic/1104241-windows-8-start-menu-modifier/
http://www.abctrick.net/2012/03/how-to-disable-smartscreen-filter-in.html
http://www.howtogeek.com/75356/how-to-turn-off-or-disable-the-smartscreen-filter-in-windows-8/
http://www.howtogeek.com/75356/how-to-turn-off-or-disable-the-smartscreen-filter-in-windows-8/
http://www.videolan.org/vlc/
http://www.extremetech.com/computing/143002-how-to-pirate-windows-8-metro-apps-bypass-in-app-purchases-and-more
http://www.pcworld.com/article/242088/worried_about_win_8_secure_boot_so_is_the_free_software_foundation.html
http://www.pcworld.com/article/242088/worried_about_win_8_secure_boot_so_is_the_free_software_foundation.html
http://www.eightforums.com/tutorials/17058-secure-boot-enable-disable-uefi.html
https://acer--uk.custhelp.com/app/answers/detail/a_id/27071/~/how-to-enable-or-disable-secure-boot
http://mjg59.dreamwidth.org/18250.html
https://help.ubuntu.com/community/UEFI
http://redmondmag.com/articles/2013/03/29/spanish-linux-group-complains-about-secure-boot.aspx

